ELECTRONIC FUEL INJELCTION

12.3” Pro Dash User Manual
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Introduction

The Holley EFI 12.3” Pro Dash is customizable with a variety of gauge and indicator screens that can be
programmed to display any parameter you need from a Holley EFI system.

Package Contents

Specifications

General
o \Weather-proof aluminum housing engineered to withstand harsh racing environments
e 12.3” High Brightness, High Contrast, Full Color Touchscreen
e 1280 x 480 Resolution
e Operating voltage 8V - 20V
e Auto Brightness
e Plug and Play connection with all Holley EFI systems via CAN bus
e Completely customizable display of all EFI parameters including every user configured input and output
¢ Multiple gauge and indicator types with limitless customization options
e Quickly toggle between two or more active screens (tune, warm-up, race, drive, etc.)
e Virtual switch panel
e User defined channel alarms
e Configurable progressive shift lights and light bar
e On screen playback of data logs
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Flexible mounting options

Mounting

Support for future USB and CAN devices
Upgradable with future software/firmware enhancements
Multiple units can be used simultaneously on a Holley EFI system for larger dashboards

Download and save Holley EFI data logs to external USB memory stick
Data logging for non-EFI installations.
Expandable internal storage on micro SD card

There are two basic ways to mount the dash, “surface” and “flush” mount. The product has six, ¥2-28 tapped
mounting holes to allow the user to “surface” mount the enclosure (mount to a flat surface or bracket).

Included with the contents of this kit is a separate template with a 1:1 layout of hole locations required for the
Y-28 holes as well as other access holes needed.

There is a cut line on the template that allows the user to recess the product to facilitate a “flush” mounting
option, which recesses the unit. Please be aware that brackets to support the back of the dash will need to be

fabricated.
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Connections

Main Connector
A 34 pin CAN/power harness supplied with the Pro Dash and is used to for power, communications, and 1/O.

The following are the required connections:

Loose Black — Connect to a “clean” ground source. Don’t ground to poor sources such as sheet metal, or a
ground point that does not have solid connectivity back to the battery.

Loose White — Connect to a “clean” switched battery power source

Loose Red — Connect to a “clean” continuous battery power source. Continuous power is heeded for a faster
GPS lock and to keep the current date and time.

“Clean” = a connection that does not share the same connections as “dirty” sources such as coils, a starter,
solenoids, fans, etc., that have a lot of electrical noise or solenoid fly-back voltage.

CAN — Connect the harness from the CAN connector on the vehicles EFI main harness to the dash using the
supplied male/female 4’ CAN/Power extension. Place the supplied terminator into the empty CAN connector.
The terminator must be used at the end of the CAN cable.



7%

S

Install CAN
terminator here.

Male/Female
CAN Extension
Cable

/

Holley EFI main harnesses use two types of CAN connectors. Earlier harnesses use a 2 pin metripak
connector. The kit includes an adapter to go from this to the 4’ extension harness (note the white power and
black ground wires are NOT needed for the Pro Dash, but need to be connected if other CAN devices require it
for their power supply). Later harnesses plug directly into the 4’ extension harness.

/

Old Style CAN Adapter

The CAN harness attached to the dash includes both male and female CAN connectors. These connectors are
wired in parallel to allow daisy chaining of multiple devices on the CAN bus.

Note that the Pro Dash does not use the CAN cabling to supply power and ground for it, unlike some other
Holley EFI CAN devices, nor does the Pro Dash supply power to the CAN cabling, which is provided by the EFI
harness.

Seal stopper provides
waterproof protection.

Depress lock tab to
remove connector.

Pro Dash CAN Cable Description
Pin | Function | Description
1 | +12Vv Power (pass through between connectors, not used for Pro Dash)
2 | CAN1H CAN_H Holley EFI communications
3 | CANIL CAN_L Holley EFI communications
4 | GND Ground (pass through between connectors, not used for Pro Dash)




CAN Extension Harness

The dash is supplied with a 4’ CAN extension harness. Holley also offers the following replacement harnesses:
558-451 — 1 foot 558-452 — 4 feet 558-453 — 8 feet 558-454 — 12 feet

Additional wires can be installed to use additional functions in the pro-dash.

Main Connector Pinout

1 2 3 4 5 6 7 8 9
GND 2v SSR1 SSR2 SSR3 SSR4 CANIH CANI1L CAN2L
10 1 12 13 14 15 16 17
CVBS1 CVBS2 Sw4a SW3 SwW2 Swi CAN2H 5V_EXC
18 19 20 21 22 23 24 25
AIN_1 AIN_3 AIN_5 AIN_7 AIN_9 AIN_11 AIN_13 IGN
26 27 28 29 30 31 32 33 34
GND AIN_2 AIN_4 AIN_6 AIN_8 AIN_10 AIN_12 SPD1 SPD2
Notes:

1. The 12V main power input (pin 2) also provides backup for the internal clock and GPS.
2. IGN (pin 25) needs to be connected to 12V to turn on the unit (low current input).

3. SSR1-SSR4 are low-side solid state relays — 1.5 Amp max.

4. 5V_EXC is used to power sensors — 450mA max.

5. CVBS inputs are reserved for future use.

The unit will draw approximately 5 mA in standby to maintain its real time clock and GPS information for quicker
acquisition.

Additional pins and plugs for the main connector can be purchased from http://www.holley.com under these part numbers:

571-135 TE SUPER SEAL TERMINALS (18-16GA) 100PK
571-136 TE SUPER SEAL TERMINALS (24-20GA) 100PK
571-137 TE SUPER SEAL PLUGS (100PK)

USB

The unit has two standard USB type C locking receptacles (USB 2.0). Connect the supplied locking cable to
either of the USB ports on the back of the unit and tighten the thumbscrews.

This cable provides a type ‘A’ receptacle that can accept USB flash drives for saving data logs, uploading
gauge screen layouts, background images, or firmware updates. You may also use these to connect to a USB
mouse or keyboard if you do not want to use the integrated touchscreen for configuration.


http://www.holley.com/

4 32 1
Type A

The USB flash drive that is included with your unit contains a user manual and can be used to transfer
configurations and log files to your computer.

GPS Antenna

Install the GPS antenna where it has clear view of the sky to the horizon for best reception. The label needs to
face down, with the black plastic part of the antenna facing up. The antenna comes with a built-in magnet and
can also be permanently mounted. For racing applications, it is recommended that the antenna be
permanently mounted using the included double-sided VHB tape.

Connect the SMA connector to the GPS antenna connector on the back of the unit. Do not overtighten the
connector, 3-5 in Ibs max.

Cleaning
If screen needs cleaning, use the supplied microfiber cleaning cloth. Do not use harsh chemical cleaners on
the touch screen display.

Do not subject the display to a high pressure water stream from a pressure washer.

Using the Dash
Touchscreen Basics

The Pro Dash has a capacitive touch screen display similar to many cell phones and does not require a stylus.
While thick gloves may not work properly, some racing gloves are available with integrated finger pads that
work with touch screens. The touch screen is used for configuration and EFI tuning. A stylus can be
purchased (if desired). Make sure that it is for a capacitive touch screen, which would be used for a cell
phone.

Pushbutton switches can be added to select functions (such as scrolling through screens) on the pro dash
while driving. For more information about these functions see the Switch to Ground (SW to GND) Special
Functions section below.

Dashboard

The following will appear the first time the dash is powered with an ECU connected, or when changing to a
different type of ECU:

dig-dash x

Q) New ECU found, do you want to load
factory default screens for this ECU?

Select Yes unless screens have been

previously loaded. Default screens can
be loaded at a later time.




Selecting ‘YES’ will load the appropriate default screens for your ECU.

There are several screen layouts that can be selected. Press anywhere on the display to bring up the
navigational buttons, then choose ‘Next’ or ‘Prev’ to cycle through the screen layouts. You can also “swipe” left
and right across the screen to cycle through layouts.

Main Menu

Pressing anywhere on a gauge screen will bring up the navigational buttons. To access the main menu
choose ‘Menu’ in the upper right corner of the screen. You can also “swipe” down to access the main menu.

Modify dash Gauge Retrieve, Utilities ECU Tuning View live
system Customizing gg'n‘i:e* f‘en‘écu Menu (HP & gauge
parameters ou Dominator screens

data logs (HP &

. onl
Dominator only) y)

Configuration Data Log Utilities Dashboard
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Configuration

The configuration screen allows you to change the display brightness, modify the number of gauge display
layouts (screens), update firmware, and calibrate the touchscreen if required.

Configuration x

Screen Clock

# of Layouts 9 M 16 Jul 2019 |T 4« 12:56:50

s - Auto
Initial Layout 1 L TZ US/Central

Brightness [l Auto

. Set Clock Sync EFI

Operating Mode

HP Reset Default Layouts

Update Calibrate Dash
Firmware Accelerometer Configuration

Layouts

You may choose the number of layouts or gauge display screens that are configured. An example would be 4
screens, representing tuning, warm up, race, and street.

Initial Layout

If Auto is unchecked, the initial power-on layout can be chosen from one of the numbered layout screens.

If Auto is checked, the power-on layout defaults to the last displayed layout when power was removed.

Auto Brightness

The dash has an ambient light sensor at the lower left corner of the display. This sensor is used to set the
backlight brightness when auto brightness is enabled. If this sensor is covered, the auto brightness feature
will not function.

Press on the “Auto” beside brightness to enable the auto-brightness function. For manual brightness control,
use the slider to adjust the screen brightness.

Operating Mode

Operating Mode is for users who wish to configure screens without first connecting to an ECU. Most users will
not use this feature as the dash automatically recognizes the ECU that is connected and gives the option to
load the default screens. Operating Mode allows the user to manually select the ECU type that will be
connected, allowing the correct channels to be configured. Pressing the “Reset Default Layouts” button will
load the default screens for the selected operating mode.

If you are not connected to a Holley ECU, choose ‘Standalone’.
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Clock

The dash has an internal real-time clock that can be adjusted using this screen. When the GPS is connected,
the clock will be automatically set (unless disabled in the dash configuration). Make sure the time zone is set
correctly.

The clock will maintain time when powered off and voltage is present on the main power input (pin 2).

About

This screen contains firmware and software version information along with the CAN id for the Pro Dash. When
connected with a Holley EFI, it will show details of the connected EFI.

Update Firmware

New or additional features developed by Holley can be added to the Pro Dash by updating firmware. These
updated firmware files can be obtained by contacting tech service (270-781-9741 or 1-866-464-6553) or they
may be downloaded from our website (https://www.holley.com/support/resources/#Fuel Injection).

To perform a firmware update, follow these steps:

1. Extract the contents of the firmware .zip file onto the included USB flash drive (unzip files and put on
USB flash drive). Always use the included USB flash drive, as others may not work properly.

2. There is a firmware update document included in the .zip file, please review it for any special
instructions.

3. Connect the USB flash drive to the USB cable on the Pro Dash.

4. Select ‘Update Firmware’ from the Configuration menu and follow the on screen prompts. The firmware
will automatically update.

5. Verify the version number using the About button after turning the dash off and on again.

‘Configuration x
Screen Clock

# of Layouts 9 M 16 Jul 2019 F - 12:56:50

Initial Layout 1~ [ Auto TZ US/Central

Brightness [l Auto

. Set Clock Sync EFI

Operating Mode

HP - Reset Default Layouts

Update Calibrate Dash
Firmware Accelerometer Configuration

Dash Configuration

This option configures the local dash settings.
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https://www.holley.com/support/resources/#Fuel_Injection

Local I/0O Tab

Configures the inputs and outputs that are available on the dash. The “Pin” refers to the pin number of the 34
pin dash connector.

o RPM will be used to display on tachometer gauges. This MUST be connected to a 12v square wave. It

can NOT be connected directly to the coil or the dash will be damaged!
e Speed is calculated using the vehicle tire diameter, rear end ratio and pulses/rev (in MPH).
o Frequency is displayed in Hertz (pulses per second).

e Custom 5v can be configured for any sensor that outputs a 0-5v signal. Holley sells a variety of 0-5v
sensors for monitoring a wide range of data.

e Custom CTS and Custom MAT are for custom thermistors.
¢ Resistance based Fuel level sending units should use 107 Pin 21.

e SSR.# are ground switched outputs suitable for use in triggering relays and devices that draw below 1.5

Amps each. Note: The SSR1 output may give a short 500mS pulse on power up.
e Switch to Ground Input is a ground switched input to the dash. The dash provides an internal pullup

current.

e Switch to 12v Input is a 12v switched input to the dash. An example of this would be turn signal
indicators.

Name

Pin

SSR Out
(2Amp)

Custom
5V Input

Switch to
Ground Input

Switch to
12v Input

100 PSI
Oil

Digital

In

Engine
RPM

RPM

Vehicle
Speed

Frequency

Holley
CTS

Holley
MAT

Custom
CTS

Custom
MAT

Custom
Ohms

Fuel
Level

io.1

X

i0.10

io.11

i0.12

i0.13

x |x |x |x

X |x |x |x

X [x |x |x

i0.2

io.3

io.4

i0.5

i0.6

io.7

X |x [x |x

x |x |x |x

X |x |x |x

X |x [x |x

x |x |x |x

i0.8

XX X X X X [X |X|X|X|X|[Xx

i0.9

spd.1

spd.2

ssr.1

ssr.2

ssr.3

ssr.4

x |x |x |x

sw.1

Sw.2

sw.3

x |x |x |x

sw.4

GROUND

Battery 12v

Can 1Hi

Can1llo

Can2Llo

future

future

Can 2 Hi

5v Output

Sensor Ground

12v Ignition

13




Local I/O CAN1 Devices Plugins Vehicle Misc

Name Type

io.1 Holley 200psi (554-103)
(disabled)
Custom 5V
Holley 50psig
Holley 100psi (554-102)
io.4 Holley 200psi (554-103)
Holley 500psi (554-136)
i0.5 Holley 1600psi (554-104)
. Holley 3000psi (554-137)
i0.6 100psi Oil Pres
GM LSx Oil Pressure Cancel

io.2

io.3

Name
Name is used to identify the input when placing gauges on the screen

Type
A number of pre-defined sensors are available from the Type pull-down list. Holley part numbers are
shown in parenthesis.

Holley 50psig

Holley 100psi (554-102)

Holley 200psi (554-103)

Holley 500psi (554-136)

Holley 1600psi (554-104)

Holley 3000psi (554-137)

100psi Oil Pressure (554-102) (overrides
oil pressure)

GM LSx Oil Pressure (overrides oll
pressure channel)

GM LSx MAP (overrides MAP channel)

GM LSx CTS (overrides CTS channel)

Racepak 200C IR temperature

Racepak Laser Height

Holley 30amp Sensor (554-170)

Holley 50amp Sensor (554-171)

Holley 200amp Sensor (554-171)

Holley 350amp Sensor (554-170)

Holley 1bar (538-24)

Holley 2bar (538-13)

Holley 3bar (554-107)

Holley 3.5bar SS (554-134)

Holley 5bar SS (554-108)

Holley CTS (534-10) (overrides CTS
channel)

Holley MAT (534-20) (overrides MAT
channel)

Some channels will override common channel names used on the dashboard screens.

Custom types give the flexibility of changing the scaling of the sensor using a graph. A gear icon will
appear beside the sensor type to allow you to configure the sensor.

Custom CTS (overrides CTS channel) Custom Ohms
Custom MAT (overrides MAT channel) Custom 5V

14



Switch to 12V (SW to 12V)
The switch to 12V type provides a low-current pull-down on each input designated as SW to 12V.
These can be used to control indicators on the dashboard screen.

Switch to Ground (SW to GND) Special Functions
The dash will provide a low current pull-up source on each input designated as SW to GND. The switch
to ground inputs can control indicators and also be used for the following special functions:

e Scroll through screens
e Take a screenshot
e Start data logging (to the dash, or USB flash drive if inserted)

These can be wired to buttons on a steering wheel or other easily accessible location.
The screenshot function allows the image to be saved internally or to the USB flash drive. When using
the screenshot function, you will be prompted to choose where the .png image will be saved, as well as

the filename.

To use, enter the desired keyword in the Name field (located in the local 1/0 tab) as shown in the table
below. You must include the square brackets, case is not sensitive.

Keyword (Name field) | Function

[next] Display the next screen layout

[prev] Display the previous screen layout

[screenshot] Capture current screen which can be saved internally
or to the USB flash drive

[log] Start recording a log file locally

Ability to Use Dash Inputs in Holley EFI ECU’s

A nice feature is the ability to use inputs to the dash actively in an HP or Dominator ECU via CANbus. This
applies only to the first thirteen dash inputs (“io.1” through “i0.13”). It does not apply to the four switched (sw.1
through sw.4) and two speed (spd.1 and spd.2) inputs. Note that Inputs 1-13 can be configured as many types
(sensor, switched, RPM).

To set this up, perform the following (this needs to be done for each dash channel used):

1) Wire the input to the dash. It is always a good idea to verify that the input reads properly on the dash.

2) In the Holley EFI software, add the Input/Output ICF. Enable (checkbox) the input, select “CAN” for the

type, and enter a name. The name can be anything you want.

15



Help ~ Help? | Datalog ~

) - -0 B [
Inputs 1-20 Inputs 21-40 Inputs 41-60 Inputs 61-80

INPUTS
NAME ECU PIN ENABLE

Dash Input #1 CAN M NOTDEFINED [ Enable

GROUKD NOT DEFINED H Enable

File > Save Toolbox ~

ﬁ - ﬂ v @ '
SENSORS

BE

PIN
MAP

Where Used

GROUMD NOT DEFINED M Enable

#1

GROUKD NOT DEFINED H Enable

3) Select the “Configure” button. Enter the following:

CAN Device — Select “Pro Dash Inputs A” for Dash Inputs 1-8. Select “Pro Dash Inputs B” for Dash
Inputs 9-13. Selecting “Pro Dash GPS” will allow use of the GPS Channels and “Pro Dash IMU allows
use of the X, Y, and Z channels from the dash G-Meter

CAN Channel — Select which dash input channel you want to use

CAN Serial — You MUST enter the serial number for the Pro Dash. You can get this through the dash
in “Configuration”, and “About”

Type — There are a couple of options. The first is to select “Raw”. Then select the desired units,
format, and range. The second choice, if the sensor used on the dash is in the dropdown, is to pick
that, which will populate the units and range. You do NOT need to select any “custom” sensor and
enter a curve. The value sent from the dash is the actual sensor reading, not an analog voltage.

The following example has Input 1 set up as a 100 PSI pressure sensor on the first CAN input (if using
the 2" CAN input on Dominator ECU select “CAN BUS 2”). The dash CAN serial number is 355 in this
example (enter serial specific to your dash).

16



Dash Input #1
SETTINGS

LN i clley 100psiq 55 (554-102) Bhvio o Dash Irputs & [

CAN EeARiiE
Bus

CAN
Serial

Sensor 0 psi Sensor 100 psi -
Min ~ Max ~

. o .
Display 0 psi Display 100 psi =
Min Max -

I
<

Units =

-

Format [

3
r

Caution 20 psi - | Caution 80 psi
Min ~ ] Max

Normal 30 psi - . ] / Normal 70 psi
Min - ; Max

I
a 1 3

B Enable Switched Caution Qutput

H Enable PC/LCD Warning Qutput H Enable Switched Warning Output

H Warning Enabled Timing Offset _

4) At this point, everything should be configured.

5) Notes on how this can be used in the Holley EFI software:

- Using this input elsewhere in the software: These dash inputs are considered a SENSOR INPUT no
matter how they are configured in the dash. If configured as a switched input in the dash, they are still
treated as a sensor input in the EFI software. A switched input is considered to be a “0 ora 1”. They
will show up anywhere a sensor input can be used, such as on an axis, or in the Input/Output ICF as a
“Sensor Input Trigger”.

In the following example “Dash Input #1”, which was configured as vehicle speed in the dash, is used on the X
axis of a 1D table in the Advanced ICF.

17



Enable Table Name [GURIEEY

Table Type: RNl

X Axis: [ REEANTE]

ACTIVATION

H AT Launch Input Enabled H Time Delay to Start
Bl switched Enable This table will activate when _ [E= Fiabled
AMD

B Advanced Enable  This table will activate when
Enable Secondary Deactivation J]J] and deactivate at Range Mode

0° is the neutral value that does not modify ignition timing. A positive value adds/increases timing.

.o o 00 0O 00 0O 00 00 00O

Offset (°)

T

Dash Input #1 (MPH)
67 | 80 | 93 | 107 | 120 | 133 | 147 | 160 | 173

18



In the following example, the ECU output will activate when RPM is above 400 and the “Dash Input #1” (which
is configured as a switched input in the dash) is turned on.

Fan Input Triggers Linked Outputs

SWITCHED INPUT TRIGGERS

Humber

AND -~

SENSOR INPUT TRIGGERS

Humber Sensor input(s) will activate switched output when enabled

This output will activate when JEERGIE: B is “

Enable Secondary Deactivation [l

This output will activate when is 400 RPM :

Enable Secondary Deactivation [l

- Note that dash inputs cannot be used for “Canned ICF Inputs”. They can only be defined as an input in
the Input/Output ICF. For example you can use an input to the dash for the “N20 Enable” in the nitrous
ICF or the “Timing Retard #1” in the System Parameters ICF. Use the input pins on the ECU for these
purposes.

- Note that the following information from the Dash is also available. To use these the “CAN Device”
needs to be set to “Pro Dash IMU” or “Pro Dash GPS”

- Accel X

- AccelY

- Accel z

- GPS Latitude

- GPS Longitude

- GPS Elevation

- GPS Speed

- Note that due to the fact these inputs are on the CANbus, they may not react within a few milliseconds.
If you are expecting an input to react within .005 seconds for example, it would be best to use an input
directly wired to ECU
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CAN Tab

Configures CAN-connected devices such as the Holley 553-107 LED Light Bar, 554-184 EGT or 554-186 EGT
Kits.

Vehicle Tab

Contains settings that control the input channel that drives the internal odometer and local RPM and speed
calculations. The speed/odometer source can be selected from EFI Transmission Speed, an EFI input, local
dash speed input or from the internal GPS receiver.

N

Local /O CAN1 Devices Plugins
Engine RPM Calculation
Cylinders 8

Speed/Odometer Source
Speed Input GPS Speed ~

Local Dash Speed Calculation
Tire Size 27.1

Pulses / Rotation 4 ok
Gear Ratio 3.73

Cancel

Trans Speed: Use with supported transmission — requires that you have a properly setup transmission ICF in
your Dominator ECU.

GPS Speed: Use this setting with the internal GPS. No additional setup is required.

Dash Speed: Use this setting when you want the speedometer and odometer to read from a speed sensor
going directly to the dash on inputs SPD1, SPD2, IO11, or I012. The corresponding channel needs to be set
to the “Vehicle Speed” type. This is the only setting that requires you to fill out the Local Dash Speed
Calculation area on the Holley Pro Dash. Note that only one of the dash input channels can be set to “Vehicle
Speed”. When this setting is chosen, a Driveshaft RPM channel will be available for gauges.

ECU Input: Use with a custom speed sensor input from the 1/0O section of your Holley ECU. The ECU input
must be named “speed” and the units set to miles/hour for the odometer to report distance accurately.
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SPEED - DIGITAL SPEED/FREQUENCY
Type [[IHEEGHIG ~

Units g

Format [

Sensor 0mph """ 60 90, Sensor 33amph -
Min - 3 -
Display 0 mph 3 Display 150mph |~
Min Max ~
Caution | Caution 85 mph .
Min Max -

Normal 0 mph .'. Normal 70 mph -
Min . Max -

[l Enable PC/LCD Caution Output [l Enable Switched Caution Qutput

[l Enable PC/LCD Warning Output [l Enable Switched Warning Output

Pulses to 4 - ses 4 pprot - Gear 410 - Tire 28.0inch -

Misc Tab

Under the Misc tab, the user has the option to set time by GPS and re-calibrate the touchscreen. The touch
screen is calibrated at the factory and should not require any adjustments. If the touch screen drifts due to
environmental factors it can be re-calibrated from this menu.

Enable Debugging should only be used if instructed by tech service.

If you are connected to a Terminator, Terminator X, or Dominator, you have a choice for local log recording in
the old .dIz or new .hdl format.

Local I/O CANI1 Devices Plugins Vehicle

Re-calibrate Touchscreen

B Enable Debugging
Set time by GPS

B Enable HDL Log (experimental)

Ok

Cancel

Dashboard

This selection returns you to the operational dash layout.
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Data Log

The Holley EFI Pro Dash allows you to retrieve, delete and configure ECU data logging with an attached HP or
Dominator ECU. Data logs can be saved internally (to the dash) or to a USB flash drive for viewing on a
computer. Additional information regarding data logging can be found on page 40.

DataLog Type
Available log files
EVENTLOG.TXT Config
11300033.DLZ

* Normal Log SystemLog

Delete Start Method

11300242.DLZ
01010819.DL
01010821.DL Retrieve

01010822.DL
Close

e Deactivated Logging Rate 100 FPS

Immediate Duration e

Triggered

Destination

« USB1 NERE]
Cancel

ECU logging: idle

Utilities
The utilities menu is described later in the manual.

Preconfigured Layouts

The Holley EFI Pro Dash comes standard with ten preconfigured gauge layouts. These ten layouts are active
by default. If a smaller or larger number of layouts are desired, select ‘Configuration’ from the Main Menu. The
maximum number of layouts ten. These layouts are also stored on the dash memory.

Below are examples of the ten preconfigured layouts:

Preconfigured Gauge Screens

(HP and Dominator default screens shown, Sniper and Terminator X defaults will vary slightly)
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(ot ~——Holley

200

( / s

[ ourwens { Press Water —{" | soontpsia

187wl | 28 N1 76, [0 5. | B25.
Layout 2

I ||

BATTERY
RERATIN

WATER
76°F

o pressuRe
Tpsi

FUEL PRESSURE
28psi

Waner

76°F

Battery
13.7 Voits

AFR Right

30.0.
25,

Layout 9 Layout 10

Customizing Your Layout

Choosing ‘Customize’ from the Main Menu enables the gauge customization mode. Entering this mode will
allow any of the preconfigured layouts to be modified, or one may be built from scratch.

Gauges can have independent warnings and ranges set, even if they are connected to the same monitored
value.
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To exit customize mode, touch on any background area (not on a gauge) to bring up the context menu and
select “Save” or “Discard changes”.

Modifying Channels on a Preconfigured Layout

Any gauge channel can be changed to meet user needs. To do this, touch the gauge to modify and press
‘Customize’. At the top right corner of the customize gauge menu is a button that will allow the user to redefine
the channel being displayed. For instance, fuel pressure on Layout 10 could be changed to display Boost.

Label

Engine RPM

Font size

10
Units

Range

Warnings
Max

Peak Hold

(disabled)
Gauge Sweep

-205 .. 45
Foreground Color

chanae...

NOTE: Only the gauge value being displayed will be updated, the user MUST manually change Labels,
Units, Range, Warnings, etc. with proper values as these will NOT be updated automatically! Refer to
the ‘Customizing Your Layout’ Section of this manual for instructions on gauge customization.

Import/Export

The import function will load any saved gauge layout (.ini file) to the active screen. The export function will
allow any gauge layout to be saved internally or to the included USB flash drive. Preconfigured layout
examples and filenames are outlined later in this manual.

Starting from a Blank Layout
To begin building a custom layout from a blank screen, touch any bare area of the background.

Choose Layout > Clear

Add... »

Layout... +  Import...
Save Export...
Background... » Clear

Discard changes

Changing the Background

The Holley EFI Pro Dash comes preloaded with a variety of background images and gauge templates (see
Appendix C). Users can also upload their own background image using the USB flash drive. Background
images should be 1280x480 resolution, in .jpg or .png file format.
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To change the background, touch an area of the background to bring up the customize menu and choose
‘Background’ | ‘Change’.

A file directory listing will show available background images. To choose one from a USB drive, select ‘USB’
on the left side of the screen and that drive’s files will then be shown. A preview of the background image is
shown to the right as you select a filename. Choose a background filename, and press OK to replace the
current background. The background image is copied to the internal memory of the dash so the USB does not
have to be present for that background to be used.

Add...
Layout...

Device Select Background Image

USBT

« Internal Abstract-BlueCubes.jpg

Abstract-PurpleStreaks.jpg
Abstract-RedCubes.|

Save
Background... » Change
Discard changes

ital-BlackChrome-Sni
AllDigital-BlackChrome-Ter
AllDiaital-BlackPerf-Hollev
AliDiaital-Blacl

Filename: AllDigital-BlackChrome-HolleyEFI.jpg

Select the background image to use for this screen, or press Ok to clear the
current background image. Selected images on an external device will be Cancel
copied automatically.

To remove the background from the current layout, press Ok without selecting a filename.

Adding Gauges

Press on the display where you want a gauge to appear, then click Add > Gauge > Value to Monitor > Gauge
Type. Once you have selected the gauge type you will be asked to select the value to monitor. Every
available EFI channel including user configured inputs and outputs will be shown in this list (see Appendix A).
Once the value is chosen, the gauge will be placed on the screen.

1. Select ‘Add’.

2. Select ‘Gauge’.

3. Select a value to monitor from the list.

4. Select the gauge type.

Analog
Add... Add... Gauge Select value to monitor Bargraph
Layout... Layout... Label RTC Bargraph Style 2
A RPM Digital
Save Save Switch Inj PW Thin Analog
Background... » Background... gftg ENEIE B :::b?:lar
. . omp
Discard changes Discard changes Target AFR z:ztuhs LED
Step 1 Step 2 AFR Left Cancel Can:el

Step 3 Step 4

Gauge Types

See page 28 for pictures of all gauge types.
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Analog
Traditional style gauge with a sweeping needle. For flexibility, individual elements can be disabled (legend,
values, border) to allow moving needles on a graphic gauge image background.

Bargraph, Bargraph Style 2

Bargraph gauges can be oriented horizontally or vertically. The second bargraph style has an angled
appearance and has a few more customization options available.

Digital Meter

Numeric value readout

Thin Analog

Round gauge with a sweeping bar instead of a needle.

AFR Meter

The AFR meter is more of a lean/rich indicator. There is a green target that shows the current Target AFR that
is programmed in the map. In closed loop, the gauge face will rotate so that the target AFR is pointing ‘north’
on the gauge. The needle and digital value shows the current AFR reading.

In this fashion, if the needle is pointing to the left the engine is running rich, and if the needle points to the right
the engine is running lean.

The AFR meter option will only appear on AFR channels.

Symbol

The symbol gauge type will change its color based on settings in the warnings section for this gauge. This can
be used to display an automotive symbol warning light or normally hidden text that will be displayed when an
alarm condition is reached.

Status LED

The status LED illuminates when the monitored value reaches the programmable caution high or low values.

Graph

The graph type show a plot of a monitored value.

RPM Bar

The RPM bar consists of 10 LEDs, comprising three programmable ranges.
e The GREEN LEDs illuminate from the minimum range value to High Warning value.
e The RED LEDs illuminate in the High Warning through High Alarm values.
The 5 BLUE LEDs illuminate once High Alarm is exceeded.

A standard configuration for a 7000 RPM shift would be to set:
e Minimum range to 4000
e High Warning to 6500
e High Alarm to 7000 rpm

26



The color of each zone can be chosen by the user.

RTC Channel
RTC is a real time clock and can be configured as an analog or digital gauge.
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Gauge Type Examples

BARGRAPH

5900 rppm

BARGRAPH?2

206s. e ®

DIGITAL METER STATUS LEDS RTC

2908

Engine RPM

AFR METER THIN ANALOG GRAPH

RPM BAR
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Customizing the Gauge

While in ‘Customize’ mode, touch the gauge you would like to modify and a menu will appear. To move the
gauge select ‘Move’ (A) and drag the gauge to place it in the desired location. To customize the visual
properties and warning indicators, select ‘Customize’ (B) from the pop up menu. In the scroll window, you can
see the parameters that are configurable.

dig-dash x|

Customize gauge

Background Color
change...
Transparency
change...
Precision
1
Segments
8
Scale values visible

> Move

Customize
Delete
Cancel

Customize gauge
Label

0 .. 8000

Warnings
[CIEELIEG)]

Peak Hold

(disabled)

Gauge Sweep

-135.. 135
Foreground Color

change...
Background Color

chance...

Customize gauge

Scale values visible
Enabled
Scale Divisor
1000
Size
400
Value Display
Enabled
Updates per second

Enabled 6/sec

Scale Divisor Border

1000 Enabled
Size Math Multiplier

400
Value Display

Enabled

Label

The Label is used to name the gauge. Use the ‘Visible’ check box to enable or disable it. To edit the label,
select the text box and a full keyboard will appear. To use a symbol instead of text, touch the ‘Sym’ button.
There are two Symbol keyboards, pressing the shift key will toggle between the two. When finished, press
‘Ok’.

Label Esc Engine RPM

The name or symbol for the gauge may be modified
here.

visible Engine RPM|

Enter

Shift

Ok
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Esc Engine RPM‘

Engine RPM

0 =0 #0 oM O] ® & O <--

E e ok =T oW B3 o= M A F§ ko=

Caps & I & & O 8 = S Enter Caps = = ./ Enter

Shift m B B B 2 8 § Shift shift 0 & m O - : Shift

<- ->  Sym Ok (0]¢

Font Size

This is used to adjust the font size of labels within the gauge. Touch inside the text box to bring up a number
keypad. The top of the keypad will display the minimum and maximum text size values (in pixels). In this
case, the minimum is 5 and maximum is 240.

Label

The name or symbol for the gauge may be modified Yo AT
here.

visible text Engine RPM
font size 20

Clear

Units
The ‘Units’ label can be modified in the same fashion as the gauge label. To do this, touch inside the text box
to bring up the keyboard. When finished, press ‘Ok’.

Units

Change the text displayed as the units. If you require
conversion you will need to edit the values under

Channel Math.

visible RPM
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Range

This will adjust the minimum and maximum display range of the gauge.

Warnings for Gauges

Configuring warnings will dictate when the gauge changes colors. When values reach the Low Warning or
High Warning value, the gauge face will change to the color beneath that value. When the gauge value

reaches Low Alarm or High Alarm, the gauge face will change to the corresponding color. You can click on the
color bar beneath the values to change the corresponding color.

Warnings

Adjust the warning set point and colors. Tap on the color
bar to adjust the colors.

Enable Low warnings
B Enable High warnings

Low Low High High

Alarm Warning Normal Warning Alarm
1| 8 150 180
] ]
Steady warning color F

Ok

Warnings for LED Status Lights or Symbols

In the case of LED Status Lights, the color of the LED is chosen by clicking on the color bar beneath the
warning values. The corresponding enable must also be set. Figure A shows an example of a CTS setup,
where the LED would change from blue, violet, green, yellow and red throughout its range of values.
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Symbols are similar, which will change color based on its corresponding value channel. In this manner you
can duplicate the function of lit symbols on your dashboard.

EIGILTE

Adjust the warning set point and colors. Tap on the color
bar to adjust the colors.

Enable Low warnings
Enable High warnings

Low Low High High

Alarm Warning Normal Warning Alarm
50 75 220 240

.
Flash rate slow |+

(0]

Figure A CTS Warning Example

Status LEDs for Switched Items (ON/OFF)

A status LED can be lit to show when an item is either on or off. To have an LED lit for when an item is turned

on, configure per Figure B. To have an LED lit for when an item is turned off, configure per Figure C. The
LED will be grey when in the normal state.

Warnings

Adjust the warning set point and colors. Tap on the color
bar to adjust the colors.

B Enable Low warnings
Enable High warnings

Low Low High High

Warnings

Adjust the warning set point and colors. Tap on the color
bar to adjust the colors.

Enable Low warnings
@@ Enable High warnings
Low Lows High High
Alarm Warning Normal Warning Alarm
0 0 1 1

Alarm Warning Normal Warning Alarm
0 0 1 1

Steady warning color d Steady warning color ]7

Figure B Blue LED when output is ON Figure C Red LED when output is OFF

32



Full color configuration and Alpha control (transparency) can be used with Status LEDs. Touch the rectangular
color bar below the value input box to change colors.

Warnings

Adjust the warning set point and colors. Tap on the color
bar to adjust the colors.

Enable High warnings
Low Low High High

Alarm Warning Normal Warning Alarm
-100 -100 100 100

Status LED Configuration

Basic colors

Custom colors e e [EGEE
- EEEN e o e
EEEEEEEN Sat:=: Green:
!al: 53 - Rlﬂp' =

édd to Custom Colors Alpha channel: [z55 :

(0]14 Cancel

Status LED Color Configuration

=

Alpha Channel example from left to right (75, 150, 255)
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Peak Hold

Enabling the Peak Hold features will place a marker at the highest and/or lowest value for quick viewing. This
feature is similar to the traditional ‘Tattletale’ Tachometers. The minimum peak is shown with a blue triangle,
and the maximum peak is a red triangle.

Gauge Sweep

Users can configure the sweep angle of Analog and Thin Analog gauges. These values are in degrees.
Positive values are in a clockwise direction and negative values are in a counter-clockwise direction. There
are three buttons that will set the sweep to a standard 270 degree, 120 degree, or 90 degree gauge. View
examples below.

0° | 12 o’clock 0° | 12 o’clock

30° | 1 o’clock -30° | 11 o’clock

60° | 2 o’clock -60° | 10 o’clock
90° | 3 o’clock -90° | 9 o’clock
180° | 6 o’clock -180° | 6 o’clock
270° | 9 o'clock -270° | 3 o’clock

Gauge Sweep

270 deg 120 deg

start -120

end 120
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Gauge Sweep Examples:

[ ]
-205 Start / 45 End

Foreground Color

[ ]
0 Start / 90 End

Changing the foreground color will modify the text, labels and values of a gauge. Use a stylus to drag the
crosshair to the desired color. The rectangular box at the bottom of the screen will show a preview of what is
being selected. Custom colors can be saved for future use by using the stylus to drag from the rectangular
preview box and drop onto one of the custom color boxes at the bottom left of the screen. Choose ‘Ok’ when

finished.

Basic colors

Custom colors

Add to Custom Colors

Hue: 0 Red: 255
Sat: |0 Green: 255
Val: 255 Blue: 255

Alpha channel: 255

0K Cancel



Background Color

Changing the Background Color of a gauge is done following the same steps as the Foreground Color. The
alpha channel controls the transparency of the background.

Basic colors

Hue: 0 . Red: 0
Custom colors sat:|0 < Green: 0
EEEEEEEN

EEEEEEEN val: 0 Blue: 0

Add to Custom Colors Alpha channel: 0

(0] 3¢ Cancel

Transparency

The transparency of a gauge background can be modified to achieve your desired style. A value of 255 makes
the gauge completely opaque, and a value of 0 makes the gauge completely transparent. This is the same as
setting the alpha channel in the color selection box for the gauge background. See the examples below.

Set the transparency (or alpha blending) of the
background color.

transparent opaque

4367. ‘
4367.

—— Engine RPM

4955

Engine RPM

Engine RPM

4636..

Transparency values are 255/125/0 Transparency values are 255/150/65/0
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Precision

Changing the precision of a gauge will show more or less decimal points after the whole number.
Tachometers generally will not use any decimal places. However, it may be beneficial to display fuel flow or
AFR values with one or more decimal place.

Precision

Changes the displayed precision of values (the
number of decimal places).

Precision 1 4
1

1.2

Segments

Users can configure the number of segments on gauges. For example, a 0-8000 RPM tachometer with 8
segments would be divided into 1000 RPM increments. A 0-16,000 RPM tachometer would be divided into
2000 RPM increments. A recommendation on the number of segments is displayed based on your choices for
range and scale divisor.

Choose 0 segments to remove the scale completely.

Segments

Change the number of major tick marks or segments
on the gauge.

Recommended values are: 1,2,4,8

Segments 8

NOTE: Ensurethe number of segments is matched up with the range you specify. E.g. If you choose
6 segments in a 0-8000 tachometer range, the scale markers will be at 0, 1333, 2667, 4000,
5333, 6667, and 8000. For this example, we would recommend using 4 or 8 segments instead.

Scale Values Visible

This will toggle the Scale Values on or off.

Scale Divisor

This value is the total range of a gauge divided by the number of segments. In this example, if you wanted the
Scale Values of the tachometer to display 10, 20, 30... instead of 1, 2, 3... the scale divisor would be set to
100 instead of 1000.
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Scale Divisor

Scale Divisor

Size

Overall Gauge sizes can be adjusted by increasing or decreasing their pixel size. The minimum and maximum
values are displayed near the top of the number keypad. In this case, the min is 20 and the max is 780.

.
400
Size Min: 20 Max: 780
Change the si:
Size

Esc Clear

Value Display

When Value Display is enabled, a digital meter will appear inside an analog gauge showing real time values in
addition to the needle indicator.

Updates per Second

This changes the speed at which values are refreshed on the dash and can be changed from 1/sec to 10/sec
or full rate. These should be adjusted upon user preference.

Updates per second
Value update rate 6/sec
2/sec

3/sec
4/sec
5/sec
6/sec
7/sec

8/sec

9/sec

10/sec

full rate
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Border
Borders around certain gauge types can be enabled or disabled by toggling this selection.

Border Style

For analog gauges, the border appearance can be changed.
Border Style

Select the appearance of the border.

Border Style ET E
Original
Black

Grey

Silver

Channel Math

Channel Math can be used to perform unit conversion on any gauge. The default value is ‘1’ and this should
be used if no conversion is desired. Any unused value may remain zero.

For simple multipliers use the ‘Multiplier (b)’ box. (Example, enter ‘1.60934’ to convert MPH to KM/H).

Conversion a b C
PSI to kPa 0 6.895 0
kPa to PSI 0 0.145 0
MPH to km/h 0 1.60934 |0

Temperature gauges can from °F to °C by using the ‘F to C’ radio button. Selecting this option will
automatically update the unit’s label of the gauge and disable the user-defined multiplier.

If any gauges appear to read incorrectly, be sure to verify that this multiplier value has not been inadvertently
changed.

Channel Math
Use math to convert or scale the channel data.

FtoC
@ User-defined

Enter the multipliers and offset to be

used (a*x*2+b*x+c)
x*2 term (a) 0
Multiplier (b) 1
Offset (c) 0

Moving a Gauge

You can move a gauge anywhere on the screen. Press once on the gauge to bring up the menu and choose
Move. Then press and hold on the gauge and drag it to where you want it to be. Guidelines are displayed to
aid in aligning the gauges.
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Adding Labels

Labels can be added anywhere on the gauge screen. The customization options for Labels include Font Size,
Foreground & Background colors, and Transparency. See below for an example of the variety of sizes, colors,
and symbols that can be used.

Customize label
Label

Label
Foreground Color

change...
Background Color

change...
Transparency

chanae...

w -
=
(=]
>
@
Qo
bt

K
ks B

Adding Switches

Switches can be placed anywhere on the gauge screen, they can be used to turn devices on or off, as a
nitrous enable, etc. These control the local SSR outputs, and additional functions are mapped through the
Holley EFI software.

Follow these steps for proper configuration:
1. Create an input in the I/O screen and give it a name — for this example we have named it “SWITCH 1”.

LAOE RN Q-4

Inputs 1-20

ECU PIN ENABLE

#1 BRI LCD-1 Enable _
PRl 5\ TCH 2 NOT DEFINED (I Conficure |
+3 BYIE NOT DEFINED [ Configure |

2. Create an output in the 1/0 screen and give it a name — in this example we have named them “Cooling
Fan”, “Elec Water Pump”, and “NOS Bottle Htr". Once named, choose ‘Configure’ at the right of the

screen.
|
AOE R VE Q-4

OUTPUTS
NAME ECU PIN ENABLE
COOLING FAN J1-810 Enable

ELEC WATER PUMP B NOT DEFINED Enable

NOS BOTTLE HTR NOT DEFINED Enable

3. Set the Switched Input Trigger to activate when ‘SWITCH 1’ is enabled.
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WOERNE Q-4

coOLING FaN

SWITCHED INPUT TRIGGERS
Number
This output will activate when [STUICR] ~ WEW Enabled -

4. Go tothe ‘PIN Map’ Icon, select ‘View LCD’ and drag the switch inputs to the appropriate pin number.

Holley EFI ECU Pin Map

| E=r s View inoctors

UNASSIGNED INPUTS

Pin  Input Number Input Type

“View mputs | viewtco |
UNASSIGNED OUTPUTS
CWATER PUMP

Pin  Output Number Output Type

2 |Ouputt e 0000000000000 ] ]
311 JOuput2 0P 0000000000000 | |
310 COOLING FAN N

[Ouputs 670 0 00000000O[ |

6. You will have to send the new configuration to the EFI and toggle the ignition for approximately 5 seconds
for the changes to be saved. Turn on the ignition to continue.

7. Place a switch on the Holley EFI Pro Dash gauge screen by choosing ‘Add’ then ‘Switch’. An option box in
the upper right hand corner of the switch customize menu will allow mapping of the switch to the proper
LCD Pin Map number that was configured in the Holley EFI software.

8. Customize the switch Label and other properties on the dash and choose ‘OK’.
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Customize Soft Switch

Label
ssr.1l

Style

Slider
Inactive Label Color

change...
Active Label Color

change...
Background Color

change...
Transparency

change...

Saving Your Layout

Once a layout has been created it must be saved. Touch any blank portion of the gauge screen and select
Save.

Exporting / Importing Layouts

You can save a copy of your layout in Customize mode by touching on any blank portion of the gauge screen
and select Layout > Export. At this point, the layout can be given a name and saved internally to the dash or to
an external USB drive (if present). Click on the filename field to bring up a keyboard to personalize the
filename. Once you have successfully saved the layout, touch any blank portion of the gauge screen and
choose ‘Save’ or you may choose ‘Save’ from the top right hand corner of the gauge screen to return to the
dashboard screen.

Device Export layout
USB2 blank.ini
* Intemnal d ”

Filename: Dash_layout_09201046

Enter filename to save the current layout.

Importing Layouts

You may import a layout from the defaults directory or USB drive by selecting Layout->Import. Navigate to the
screen you want to import and select Import. Touch any blank portion of the gauge screen and choose ‘Save’
to return to the dashboard screen.

Start-up Gauge Layout

The dash will use the last saved layout as the start-up layout. If a specific default screen is desired, go to the
Main Menu and select Configuration, then deselect Auto and select the desired initial layout number.
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Data Log Record and Playback

Local Data Record

The Holley EFI Pro Dash has a record button that will record data logs directly to the USB flash drive if
inserted, otherwise it will log to internal dash storage. The record button can be shown by pressing anywhere
on the dashboard display.

Pressing this button will record accelerometer data, local dash inputs, ECU broadcast data, and the data from
the optional GPS directly to a USB flash drive or internal storage.

The data is recorded in the standard Holley Log File format and can be examined using PC software.

Data Log Playback

The Holley EFI Pro Dash will play back logs that have been locally
recorded using the ‘Record’ button or retrieved from an HP or
Dominator ECU. Pressing the ‘Playback’ button on the right side of
the dashboard screen allows you to play back these logs from the
dash’s internal storage or a USB drive.

The data log playback will animate the gauges with data that has
been previously recorded. To return to the live data display, a
‘Stop’ button can be used from on the on-screen menu to stop the
playback at any time.

When an HDL formatted log file is played back, a slider appears

that can be used to move forward and backward in the log file for
review. Pressing on the play button at the right toggles between
play and pause mode.

12:19:22.42 12:19:21.78

To exit playback mode, tap the background and press stop.

USB Flash Drive Removal

If a USB Flash drive is plugged into one of the USB ports on the Pro Dash, an eject button will appear in the
lower right corner of the dashboard on-screen menu. This ensures that all files are closed on the USB drive
allowing a safe removal.
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Utilities Menu

From the utilities menu, you can upload/download global EFI configurations, access file utilities, backup/restore
the dash configuration, and adjust security settings. Press on the ‘X’ at the top left corner to return to the main
menu.

(%) utilities

Globhal Config

File Util

Backup/Restore

Reset USB

Security Settings

Global Config

A global configuration contains the complete configuration of a Holley EFI in a single .hefi file. The dash can
upload and download global configs to the connected EFI.

Downloading the Current EFI Configuration

Connect a USB flash drive to one of the USB cables attached to the dash. Navigate to the desired device and
folder where you want to store the current EFI configuration, and press Download to start the transfer.

Current EFI configuration

WTS-Test-NoDBW.hefi

Device Available EFI configuration files

USB2 config.hefi Upload
* Internal | defaults | to ECU |
images
logs P
lost+found ‘ Delete ‘
WTS-Test-NoDBW . hefi

Select a directory to download the current configuration
into, or select a .hefi file to upload.

‘Qlose‘

Uploading a New EFI Configuration

To upload a new configuration to your Holley EFI, first ensure that the engine is not running. Navigate and
select the desired .hefi configuration file and press Upload to ECU to start the transfer.
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Deleting EFI configuration files
If you no longer want to have a copy of the .hefi file, you may remove it. Navigate to the desired file and press

Delete.
File Utilities

The utilities screen allows users to perform file functions such as deleting files and copying files to a USB flash
drive.

Source Destination

Name Name
A/ [ ./
& internal
&= images
B Abstract-BlueCubes.jpg 184 KE
B Abstract-PurpleStrea... 76 KE
B Abstract-RedCubes.jpg 184 KE

B AllDigital-BlackChrom... 172 KE
B AllDigital-BlackChrom... 170 KE
B AllDigital-BlackPerf-H... 126 KE
B AllDigital-BlackPerf-S... 125 KE
B Rlaclkl eather inn 277 ll(TF’7 Refresh

Multiple files can be selected at once to make copying easier.

Backup/Restore

Backup/Restore can be used to duplicate a dash configuration on a new dash. The backup includes all local
dash configuration settings and screen layouts.

Backup
To create a backup copy of the complete dash configuration, choose Backup Configuration.

Device Backup Dash Configuration

USB2 Dash_Config_20160908.tgz
defaults
images
logs
lost+found

Filename: |Dash_Config_20160920

Enter a filename to save the dash configuration as. ‘ Cancel ‘

Navigate to where you want the backup file stored, adjust the filename if necessary, and press Save.
Restore

To restore a previously saved configuration, select the Restore Configuration from the menu, locate the
desired .tgz file, and press Restore.
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Service Menu
This menu permits you to preset the odometer and to reset the trip 1 / trip 2 odometers.

Security Settings

The dash has the ability to lock out certain functionality. To disable a particular feature, place a checkmark
beside the feature you wish to lock out.

Default Password

Before you can change any settings, you will need to enter the default password of “holley” (without quotes).

Item
Internal Datalog
Screen 1-4 Edit

Screen Edit/Customization
ECU Log

ECU Tuning

ECU Global
Upload/Download
Firmware Update

File Util

Backup/Restore
Standalone Choice

Dash Configuration

Odometer Source

Adjust Security Settings

Lock Out

Press unlock to adjust settings

Enter the current password to unlock

The default password can be found in the Dash user manual.

O Cancel| | |

Effect when checked (locked out)

Does not allow the user to record or play back a locally recorded logfile.
Does not allow the user to change the first four layout screen on the
dashboard. Screens 5-10 are still editable.

No screens can be edited or customized.

The user cannot download log files from the ECU.

The ECU Tuning menu is disabled

Global .hefi files cannot be uploaded or download to/from the ECU.

The firmware cannot be updated on the unit.

File utilities menu is disabled

Dash backup and restore functionality is disabled

The user cannot switch between standalone and EFI-connected mode.
The user cannot change the local dash channel configuration, can device
configuration, vehicle settings, or touchscreen calibration.

The odometer source cannot be changed.
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Once you have changed the options, press the lock box to activate and protect the option selections. You can
lock using the same password as before, or enter a new password.

Note that if you change the password from the default, the first three characters will be displayed as a
password hint in the unlock screen.

If the options are greyed out, you will need to enter the password before you can change the options.

Press lock to use the current password, or you
can choose to create a new password.

| (O cancel | [ Lock |

Note that if the password is forgotten, the unit will have to be returned to Holley to be reset to factory settings.
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EFI Tuning

The Pro Dash has been equipped to tune most of the EFI parameters for HP and Dominator ECU’s. Tuning is
not supported for Sniper, Terminator X, and Terminator X Max systems. The 3.5” handheld included with
those systems can be used for tuning. It is expected that the user is familiar with the PC tuning software and
general EFI tuning principles in order to use the tuning functions on this dash.

From the main menu, choose the Tuning menu to adjust most of the parameters in your Holley EFI.

Menu Organization
The left side contains the list of menus and items that can be used to change parameters on the EFI.

Menu Parameters

Basic Basic tuning parameters including fuel, closed loop/learning speed, spark, and
transmission shifts.

Advanced Tuning Detailed fueling, idle, spark, and individual cylinder tuning.

Performance Performance items such as Launch, Rev Limiters, Nitrous, Boost, Traction
Control, Water/Methanol, and Advanced Tables.

System Setup Initial EFI configuration and other system options including Fans, Fuel Pump, A/C

Shutdown, Engine Setup, Diagnostics selection, Ignition, and Transmission. TPS
autoset and Static Timing are also available from the System Setup Menu.
User 1 — User 4 Four user-customizable menus

(%] Tuning

Basic

Advanced Tuning

Performance

System Setup

User 1

User 2

Using the Tuning Menu

There are a number of different editors based on the value you choose to edit. The current value is displayed
in light blue beneath the parameter label.

Enable/Disable Toggle

Pressing on a toggle type menu item will toggle the state between disabled and enabled. Note that some
additional parameters may appear in the menu list once enabled. For example, the Fan 1 on and off settings
are not shown if Fan 1 is disabled.
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Numeric Editor

Selecting a parameter with a numeric value will bring up a numeric keypad and slider bar on the right half of
the screen. You may use either the slider or keypad to change the value. The parameter limits are shown
near the slider bar.

| |Prev.‘ Tuning:Basic:Basic Fuel:Target AFR

Target AFR Idle Target AFR Idle

Target AFR Cruise
14.0 A/F

Target AFR at WOT
12.5A/F

‘E‘ | Cancel ‘

Pull-Down/List

Parameters that have specific choices are displayed in a pull-down list. The current setting is displayed in
blue, and pressing on the parameter brings up a pull-down list on the right side.

‘z| |E‘ Tuning:Basic:Closed Loop/Learning

Select new value for Fuel Learn Speed

Closed L
EHZITJTEd oop Fuel Learn Speed Fast =[;

Slow
Medium
Closed Loop Speed

Base Fuel Learn
Enabled

Fuel Learn Speed
Fast

‘E‘ | Cancel ‘
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Graph Editor

Parameters that are graphical will bring up the graph editor. Graphs can be edited by selecting a point and
dragging it up and down, or by clicking on the yellow value box near the point you wish to edit.

Modify value

p . a
N
. ISR B O B SR L~
‘]UU 0.25 050 0.75 1.00 | )y P 350 37%
|Set| ‘Cancel

|§‘ | Cancel:‘

Multi-series graphs have a selection on the right hand side to select the series you are editing. The series that
can be edited is shown in yellow. In the example below, 3-4 Upshift is selected.

3rd-4th Gear
200 T

¢ 3-4Upshift

Speed (MPH)

4-3 Downshift

|§‘ | Cancel ‘
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Table Editor

In table editor, you can select a single cell or multiple cells to edit. Press once on a single cell to select it, and
then press a second time to bring up the numeric table editor.

Multiple cells may be edited by first pressing and dragging to highlight the desired cell range in blue. Press on
any blue selected cell to bring up the numeric table editor.

Base System Fuel Flow Rate (Ib/hr)

| 500 | 600 | 700 | 800 | 900 |1050|1200| 1400 | 1600 | 1800 | 2000 | 2250 | 2500 | 2750 L
999510.0 23.0(36.0/49.0|/62.0|75.0 88.0 101.0/114.0 127.0 140.0

5 223 346 46593 716 639 %3 1086 1208
o5 |25 323 459 579 699 a1 529 1059 1178
25215 332/ 449 565 602 199 915 1082 1145
+ n2s2s s 502 05 710 132 1005 M8 )

0 5o ot 1103 nss

-mm-mnmm

Aas e l1asnl11iaaliat 2laaa n'_-|r
¥

| Smooth ‘ ‘ Save | | Cancel |

To perform smooth and interpolate operations, first select a range of cells. Then, press on any selected cell to
bring up the editor. Select Smooth or Interpolate, and then press Ok.

A/F Ratio Offset (CTSvs MAP)
-40 | -20| 0 | 20 | 40 | 60 | 80 | 100120 |140|160|180|200|220|240/260

Apositive value makes the target A/F value leamer, a negative value makes it richer. A value of 0.0 performs no change.

‘_%‘ |Cance|‘

Function

Set Value
Add/Subtract
Offset by %

Multiply s ‘ | Clr |
Divide -
Smooth Selection B ENIED ‘ Apply ‘
Interpolate Selection |

‘ Cancel ‘

To perform an action, select the desired function, type in a value, and press Apply. Changes are not sent to

the EFI until the ‘Save’ button is pressed.

Function Description

Set Value Sets all selected cells to the same value

Add/Subtract Adds an offset to the selected cells.

Offset by % Offsets each selected cell by a percentage. 100% doubles the value.

Multiply Multiplies each selected cell by a value

Divide Divides each selected cell by a value

Smooth Selection Smooths the selection using neighboring cell values

Interpolate Selection Perform a linear interpolation of values using the four corner cells in the
selection
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User Customizable Menus

You can change the title of the user customizable menu by pressing on the menu label for more than 2
seconds. A keyboard will appear allowing you to change the name of the menu.

To add items to a user menu, you must first navigate to the desired item. Press on the desired menu item
label for more than 2 seconds. A dialog box will appear, allowing you to select which menu to add or remove

this item to.

|z‘ |E| Tuning:System Setup:Fans

Enable Fan #1
Disabled Enable Fan #1
Select the user menus you want this parameter to appearin.
Enable Fan # s User1
Disabled User 2
User 3
User 4

20K
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Appendix A

List of EFI Monitored Values

Below is a list of 315 values that can be monitored (if applicable). Any user programmed I/O values will appear
in the list in addition to these once the dash has been connected to a Holley ECU. Note that this list is
dependent on the ECU type and software version.

RTC
RPM
INJ PW
DUTY CYCLE
CL COMP
TARGET AFR
AFR LEFT
AFR RIGHT
AFR AVERAGE
AIR TEMP ENR
COOLANT ENR
COOLANT AFR OFFSET
AFTERSTART ENR
CURRENT LEARN
CL STATUS
LEARN STATUS
FUEL ECONOMY
FUEL FLOW
MAP RoC
TPS RoC
TUNING CHANGE
ESTIMATED VE
IGNITION TIMING
KNOCK RETARD
KNOCK LEVEL
IAC POSITION
MAP
TPS
MAT
CTS
BARO
BATTERY
OIL PRESSURE
FUEL PRESSURE
PEDAL POSITION
MAIN REV LIMIT
REV LIMIT #1
REV LIMIT #2
AC KICK
TIMING RETARD #1

INJ PW1
INJ PW2
INJ PW3
INJ PW4
INJ PW5
INJ PW6
INJ PW7
INJ PW8
INJ PW9
INJ PW10
INJ PW11
INJ PW12
CYL FUEL CORR1
CYL FUEL CORR2
CYL FUEL CORR3
CYL FUEL CORRA4
CYL FUEL CORR5
CYL FUEL CORRG6
CYL FUEL CORRY7
CYL FUEL CORRS8
CYL FUEL CORR9
CYL FUEL CORR10
CYL FUEL CORR11
CYL FUEL CORR12
CYL FUEL CORR13
CYL FUEL CORR14
CYL FUEL CORR15
CYL FUEL CORR16
CYL TIMING CORR1
CYL TIMING CORR2
CYL TIMING CORR3
CYL TIMING CORR4
CYL TIMING CORR5
CYL TIMING CORRG6
CYL TIMING CORR7
CYL TIMING CORRS8
CYL TIMING CORR9
CYL TIMING CORR10
CYL TIMING CORR11
CYL TIMING CORR12
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N20 STAGE 6
N20 STAGE 7
N20 STAGE 8
GPO1
GPO 2
GPO 3
GPO 4
GPO 5
GPO 6
GPO 7
GPO 8
N20O ENABLED
N20O INPUT #1
N20 INPUT #2
N20O INPUT #3
N20 INPUT #4
N20O INPUT #5
N20 INPUT #6
N20O INPUT #7
N20 INPUT #8
N20 PURGE
N20 LEAN CUTOFF
N20O RICH CUTOFF
N20 RPM CUTOFF
N20O MAP CUTOFF

N20 PURGE OUTPUT

N20O DRY FUEL 1
N20O DRY FUEL 2
N20O DRY FUEL 3
N20O DRY FUEL 4
N20O DRY FUEL 5
N20 DRY FUEL 6
N20O DRY FUEL 7
N20 DRY FUEL 8
N20 TIMING MOD1
N20 TIMING MOD2
N20O TIMING MOD3
N20 TIMING MOD4
N20 TIMING MOD5
N20 TIMING MOD6

DIAG #10
DIAG #11
DIAG #12
DIAG #13
DIAG #14
DIAG #15
DIAG #16
DIAG #17
DIAG #18
DIAG #19
DIAG #20
ADV LAUNCH INPUT
ADV SHIFT INPUT
ADV GEAR
ADV AT 1D1
ADV AT 1D2
ADV AT 1D3
ADV AT 1D4
ADV AT 1D5
ADV AT 1D6
ADV AT 1D7
ADV AT 1D8
ADV AT 2D1
ADV AT 2D2
ADV AT 2D3
ADV AT 2D4
ADV AT 2D5
ADV AT 2D6
ADV AT 2D7
ADV AT 2D8
ADV AT 1D/GEAR 1
ADV AT 1D/GEAR 2
ADV AT 1D/GEAR 3
ADV AT 1D/GEAR 4
ADV AT 1D/GEAR 5
ADV AT 1D/GEAR 6
ADV AT 1D/GEAR 7
ADV AT 1D/GEAR 8
ADV AT 2D/GEAR 1
ADV AT 2D/GEAR 2



TIMING RETARD #2
TIMING RETARD #3
FAN #1
FAN #2
#2 FUEL PUMP
AC SHUTDOWN
TCC LOCKUP
SENSOR WARNING
SENSOR CAUTION
BASE FUEL LB
BASE FUEL VE
BASE TIMING
BASE TAFR
BASE IGN DWELL

VOL COMP IGN DWELL

INJ END ANGLE
ECU LOG TRIGGER
TIMING AIR TEMP

TIMING COOLANT TEMP

STATUS1
STATUS2
STATUS3
STATUS4
STATUSS
STATUS6E
STATUS7
STATUSS
INJ PPH1
INJ PPH2
INJ PPH3
INJ PPH4
INJ PPH5
INJ PPH6
INJ PPH7
INJ PPH8
INJ PPH9
INJ PPH10
INJ PPH11
INJ PPH12

CYL TIMING CORR13
CYL TIMING CORR14
CYL TIMING CORR15
CYL TIMING CORR16
TGT FUEL PRESSURE
BOOST PSIG
BOOST GEAR
BOOST STAGE
BOOST
BOOST SPEED
BOOST TIME
TARGET BOOST
TRANS BRAKE
BOOST SCRAMBLE +
BOOST SCRAMBLE -
MANUAL BOOST BUILD
MANUAL BOOST RESET
BOOST BUILD
BOOST SOLENOID DUTY
BOOST SAFETY
BOOST MASTER ENABLE
BOOST MANUAL SHIFT IN
BOOST MANUAL STAGE IN
BOOST FILL SOL DC
BOOST VENT SOL DC
W/M INJECTION
W/M MANUAL ENABLE
W/M LOW FLUID
W/M PUMP STATUS
W/M SOL FLOW1
W/M SOL FLOW?2
W/M TOTAL FLOW
W/M SOL DC1
W/M SOL DC2
N20 STAGE 1
N20O STAGE 2
N20O STAGE 3
N20O STAGE 4
N20 STAGE 5
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N20 TIMING MOD7
N20O MTIMING MODS8
N20 TIMER1
N20 TIMER2
N20 TIMER3
N20 TIMER4
N20 TIMERS
N20 TIMERG
N20O TIMER7
N20 TIMERS8
TRANS GEAR
TRANS SPEED
LINE PRESSURE

INPUT SHAFT SPEED

ACCUM PRESSURE
TCC DUTY CYCLE
LINE TEMP
TORQUE TIME

TRANS MAN UPSHIFT
TRANS MAN DNSHIFT

TRANS AUTO/MAN
TB TPS #1
TB TPS #2

PEDAL TPS #1
PEDAL TPS #2
TB2 TPS #1
TB2 TPS #2
TB POSITION
TB2 POSITION
BRAKE PEDAL
DIAG #1
DIAG #2
DIAG #3
DIAG #4
DIAG #5
DIAG #6
DIAG #7
DIAG #8
DIAG #9

ADV AT 2D/GEAR 3
ADV AT 2D/GEAR 4
ADV AT 2D/GEAR 5
ADV AT 2D/GEAR 6
ADV AT 2D/GEAR 7
ADV AT 2D/GEAR 8
ACC X
ACC Y
ACC Z
GPS QUAL
GPS SPEED
GPS LAT
GPS LONG
GPS ELV
GPS DIR
DASH 101
DASH 102
DASH 103
DASH 104
DASH 105
DASH 106
DASH 107
DASH 108
DASH 109
DASH 1010
DASH CAN1
DASH CAN2
DASH CANS3
DASH CAN4
DASH CANS5
DASH CANG6
DASH CAN?7
DASH CANS
DASH CAN9
DASH CAN10
DASH ODOMETER
DASH TRIP 1
DASH TRIP 2



Appendix B

The following are additional complete layouts that can be found in /internal/defaults. These are intended for HP
and Dominator ECU’s, but can be modified for use with Sniper, Terminator X, and Terminator X Max
applications

1

Oil Pressure

nismo blue

—— WATER —— BATTERY ——— —OILPRESSURE —  — FUELPRESSURE— [ —AFRLEFT—— [ AFRRIGHT ——

76. 13.7- LR 30.0.

blue 1
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N20 Enabled N20 Input #1

rN20 Stage 17  N20 Stage 2 1 — AFR Right —, — Target AFR — — Fuel Flow —

30.0. 13.4. 30.b,h,

cTS —CTIs— — MAP —— —— MAT —

76- 67.. S 3.7...

— Oil Press —; — Timing —

| 25..,

Oil Press

AFR Average

DP race 1

————————— Engine RPM ————————— 2:04:17am

Batt———

oo 1 : . oy % . ; 1 3 7Volts
k ’ f; - ) K r— Fuel Press —
; 43 3.*‘ : ' 2 ) . A ’ 28psi
C PUMP "

~ Oil Press

1.

AFR Right
30.0 A/F
‘e

GFrace 1

=
sV

/N 55 »

< -15aime 15

—-25 25— )

18 7

/> 15 voits 20/’ ]20140

Tjo 184 \ ™00 MPH
--80
/\\15 | //60 Acqg S\t
. 40 5 a

/ \
(R

Analog Gauge 1
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Vi \

= 1231}'._36 Z > 1%, h;s 4

=12 14.8= =10 18—

-

8 1420
7/ “ N

Battery
1 3.7 \(olts _

) 110 140 17.0 2

Fuel Pressure — 1)
28 psi

25 50

r AFR Right

30.0ar

Modern Blue
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—— BATTERY
13.7 Volts

12.0 16.0 20.0

——— WATER———
T6°F

— OIL PRESSURE ——
1 psi

0
r— FUEL PRESSURE —
28 psi
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Red Analog
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1:52:00AM
AFR LEFT ———

16.0

AFR RIGHT
Y

r——— Boost
-5 psig
Timing
~ 19deg

24 36




Appendix C

The following preloaded background images can be found in /internal/images.

Cockpit — 5 Color Versions Available

DarkPerforated

Ducati — 6 Color Versions Available
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GalaxyFire

GeoTexture

GrungeMetal — 6 Versions
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HolleyLS — 3 Versions

LaFerrari-Digital — 4 Versions

Meltdown
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Modern-Base — 4 Colors

Nismo-Blue
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